
1975: Right Click

|< < PREV COMIC #1975 (APRIL 1, 2018)  (HTTP://WWW.XKCD.COM/1975/)
NEXT > >|

Right Click

Title text: Right-click or long press (where supported) to save!

NOTE: The above is what is seen when viewing the comic on xkcd.
But it is just the stating point of an interactive comic experience, which begins when you Right
Click the comic.
To experience the interactive content, click here (https://www.xkcd.com/1975/) .
See an example of what happens in the Trivia section below.

Explanation

This explanation may be incomplete or incorrect: Please add an explanation table of all
functions This is an April Fools comic, so it'll take a while to get organized and much longer
to fill out. Do NOT delete this tag too soon.
If you can address this issue, please edit the page (//www.explainxkcd.com

 add a comment! (//www.explainxkcd.com/wiki/index.php?title=Talk:1975:_Right_Click&action=edit)
 ⋅   add a topic (use sparingly)! (//www.explainxkcd.com
/wiki/index.php?title=Talk:1975:_Right_Click&action=edit&section=new)  ⋅   refresh comments!
(//www.explainxkcd.com/wiki/index.php?title=1975:_Right_Click&action=purge)
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/wiki/index.php?title=1975:_Right_Click&action=edit) ! Thanks.

This was the eighth April fools' comic released by Randall. The previous fools comic was not from the
year before as there was no such comic released in 2017. Instead the previous one was 1663: Garden,
scheduled for released Friday April 1st 2016, but in the end released on Monday April 4th 2016.

It will thus be interesting to see if 2019 will be year with or without an April Fools' Day comic. It falls on a
Monday so on a scheduled release day. However, this does not necessarily mean anything, because this
year Randall once again moved the release day, from Monday April 2nd to Sunday April 1st. This comic
thus replaced the Monday release, the second time this happens due to April 1st, last time was back in 2012
with 1037: Umwelt, the first time Randall made such comics in consecutive years. That streak ended after
6 comics in 2017, but a new streak may have started now.

This comic pokes fun at how hard it can be to save an image or to just navigate context menus in some
computer programs. Likely it is also a reference to the movie "Ready Player One", based on the book by
Cline: in the movie, in fact, the purpose was to find an Easter Egg hidden in an Atari video game named
"Adventure".

This is an interactive comic which manipulates the context menu of the browser. This menu is typically
accessible by a right-click, hence the title, or a long press on mobile devices without a mouse. The title is
reminiscent of one of the first interactive comics 1110: Click and Drag, where the title explains what the
user should do to experience it. However, that was not a fools' day comic!

It should be noted that if you DO manage to save the image somehow (Possibly by right-clicking before
the javascript loads, or by pulling it from the source, or by right-click saving it normally from unixkcd), it
just shows the initial image of the page with nothing changed. There is not additional joke by actually
being able to save the image. Note that if you dig deep enough, there IS a way to save the image from the
right click menu, and it DOES get you a different image. However, the other ways previously mentioned
do not give you that image, even though you are saving the image.

The comic uses JavaScript and HTML5 to override the standard context menu. Since modern browsers use
the same features to integrate Add-ons into that menu, the behavior may be different depending on the
browser environment. Browsers with JavaScript disabled, either totally or by using NoScript, won't access
the functionality of the comic, but of course can easily save the image.

The manipulated context menu is described below.

Context menu
Main Context Menu
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# Menu
Item Explanation Sub-Menu Items

1 Save

Only appears after
successfully
completing the
ADVENT.EXE
game or getting the
Easter egg in
Mornington
Crescent.

Save image> Downloads this image. [1] (https://xkcd.com
/1975/v6xso1_right_click_save.png) . The image includes a spheroid
object near the top right-hand corner which appears to exhibit red shift
and green shift, suggesting that it is rotating rapidly.

2 File Normal submenu

Close: Closes menu, does nothing.

Open: A:\, C:\, / (See more below)

Find: Where, When, How, (grayed out) What, (grayed out) Why, Who.

'Where' leads to four options. The first, 'computer', has two options
('folder' and 'menus'), which link back to the 'find' and right-click menus,
respectively. "Narnia" leads to a link to the comic 665: Prudence as well
as to a grey comment about how it's weird that "they" have to die to go
back to Narnia. "Canada" and "America" lead to the same set of bizarre
menus (America leads into Canada's menu), which then give the options
'Upper' and 'Lower', ultimately leading to a drive-through and hockey,
respectively.

'When' leads to a description of Siri entering someone's home, and the
menu can be followed to reveal several further events from 'earlier' in
the day. The last one ('a bottle of jack and a toothbrush') is likely a
reference to the song 'Tik Tok' by Kesha.

'How' simply leads to an exclamation of 'How!?'.

'What' is grayed out.

'Why' links to [2] (http://itisamystery.com/) , technically answering the
question of "Why?"

'Who' leads to a menu version of the Abbot and Costello "Who's on
First?" routine, which eventually links to a youtube video
(https://www.youtube.com/watch?v=kTcRRaXV-fg&feature=youtu.be)
of the routine. As of April 4th, a second submenu has been added, which
contains Slappy and Skippy's "Who's on Stage?" parody of the previous
routine, which also eventually leads to its youtube video
(https://www.youtube.com/watch?v=Mdqv5xIsFLM) .

Backup: Causes the area around the comic to flash red 9 times, with
high-pitch sounds reminiscent of a truck backing up. Likely a pun.
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Save: Only available after the save menu is unlocked after one of the
two Easter Eggs is found, allows download of bonus comic.

3 Edit

Enables a mode
allowing the user to
draw on the
webpage. Pressing
Esc asks "Aw, that
looks nice though.
Really delete?" and
the page returns to
normal if OK is
clicked.

None

4 System Normal submenu

Shut Down> Changes the only menu option to "Power on", then once
that is used, system returns to normal.

/ (See below)

5 View Normal submenu

Cascade>Links to [3] (http://wiki.xkcd.com/geohashing
/Mt._St._Helens,_Washington)

Tile> Links to 245: Floor Tiles

Minimize> Changes pointer to a smaller pointer.

Full Screen> Enters full screen.

6 Utilities Normal submenu

Park drives> Nothing.

Check space usage> (cannot click) Space usage: -Dark matter
-Hydrogen -Helium -Scattered clumps of heavier elements -Stars -Rocks
-Some space probes -Earth

Spell check> English (links to 1069: Alphabet) and Colors (links to
[4] (https://blog.xkcd.com/2010/05/03/color-survey-results/) )

Train AI> links to 1838: Machine Learning

Identify song> opens a long word-by-word menu for song lyrics; it's
actually a menu-ised version of 851: Na.

Advanced> several Unix commands, all absurd (or dangerous) for some
reason:

apt-get install /dev/null: apt-get is the standard package
manager used in Debian-derived Linux distributions (including
Ubuntu); it is normally used to install software; /dev/null is the
"bit-bucket" device on any Unix system, which can be used as a
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dummy output file to discard output or as a dummy empty input
file. This command would attempt to install /dev/null (which is a
device, not a package!) or, more correctly, would try to install a
package reading its data from /dev/null (if apt-get is given a
file name it tries to interpret it as a .deb package), which is
obviously impossible.
brew install apt-get: brew is a third-party package manager
for macOS; it is generally used to install "missing" open-source
utilities on a macOS system; the command is attempting to install
the aforementioned apt-get, which is both impossible (apt-get
doesn't run on macOS) and hilariously recursive (did you install a
package manager - brew - to install another one?). Even if this
were possible, the package would have been called apt, as apt-get
is only one of the commands in the package manager.
/usr/local/bin/wine xen-hypervisor.exe: wine is a
compatibility layer used to run Windows executables on Linux
(and on macOS); the fact that it is in /usr/local hints that it has
been manually compiled on this machine; Xen is a Linux-based
hypervisor, i.e. a software used to run and manage virtual
machines over a Linux host, but the .exe suffix here hints that it is
a Windows executable. The command would try to launch a
Windows build of a Linux-based virtual machine manager on a
Unix machine through a Windows emulation layer (wine).
source .bash_history: the source shell command reads the file
that is given as argument and executes each of its rows as a
command in the current shell, roughly as if you typed them in;
.bash_history (located in the user home directory) is the file
where the bash shell saves the history of the commands that have
been run. This command would re-run all the command that have
been typed in the shell.
rm -rf $DIRECTROY/*: rm -rf deletes recursively and forcefully
the paths it is given as arguments; $DIRECTROY is a shell variable,
probably containing some directory that whoever typed in this
command wanted to clean; however, it is misspelled (it says
$DIRECTROY, not $DIRECTORY), and, due to how POSIX shell
work, it is thus expanded to an empty string; so, the command
becomes rm -rf /*, which deletes all the files and directories in
the root of the disk, effectively killing the system instead of just
deleting the content of some directory. Notice that this particular
misspell manages to circumvent the builtin protection of many rm
versions, which refuse to do a plain rm -rf /, as /* gets
expanded by the shell, so rm never has the chance to see explicitly
that you are killing all the data in the root directory.
:(){:|:&};:: this is a classic shell fork bomb
(https://askubuntu.com/q/159491/208527) , i.e. a small program
that keeps launching copies of itself, until all resources have been
exhausted or the user somehow manages to kill all its copies.
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echo "source .bashrc" >> .bashrc: .bashrc is a file that gets
executed whenever the bash shell is started in interactive mode;
this command appends the string source .bashrc to it, which
effectively executes it again recursively; this would pretty much
make it impossible to open an interactive shell when launching it
with the default parameters.
alias gcc=php: the alias shell builtin create an alias for another
command; gcc is the GNU C compiler driver, which is used to
compile programs written in the C language; php is the command-
line interpreter for the PHP language. This line creates an alias
such that when typing gcc, php is actually invoked, which would
generate completely absurd error messages. This is doubly
devious, as PHP isn't generally held in high esteem by large part
of the programming community (especially by someone writing
stuff in C).

'); DROP TABLE Menus;-- links to 327: Exploits of a Mom

7 Games Normal submenu

Twenty Questions> A Twenty Questions interface that gets really
confusing. There are links to Bing image searches for 'okapi
(https://www.bing.com/images/search?q=okapi&FORM=HDRSC2) ',
'pronghorn (https://www.bing.com/images/search?q=pronghorn&
FORM=HDRSC2) ', 'eland (https://www.bing.com/images
/search?q=eland&FORM=HDRSC2) ', 'baribusa (https://www.bing.com
/images/search?q=baribusa&FORM=HDRSC2) ', 'musk deer
(https://www.bing.com/images/search?q=musk%20deer&
FORM=HDRSC2) ' and 'ibex (https://www.bing.com/images
/search?q=ibex&FORM=HDRSC2) '. The game also contains some
extremely large cans of creamed corn (a reference to 1807: Listening).

Rock Paper Scissors> A Rock Paper Scissors game where the computer
always matches your move. If you go long enough, the Defect option is
added, a reference to the Prisoner's Dilemma (https://en.wikipedia.org
/wiki/Prisoner%27s_dilemma) .

D&D> A complex Dungeons and Dragons interface. Allows you to cast
various spells from D&D 5e which link to various pages, including xkcd
comics (e.g. 1331: Frequency), what-ifs (e.g. Saliva Pool
(http://what-if.xkcd.com/144) ) and other external sites (e.g. The Sun |
NASA (https://www.nasa.gov/sun) ). See post on /r/dndnext
(https://www.reddit.com/r/dndnext/comments/88vwoe
/xkcds_latest_comic_has_a_dd_easter_egg/) for all 285 links and 11
extra effects.

ADVENT.EXE> A text-based game. If played correctly, you can win,
unlocking 'Save'>'Save image' from the beginning menu, which links to
[5] (https://xkcd.com/1975/v6xso1_right_click_save.png) .
'ADVENT.EXE>Castle>Well>Wish for...' has links to comics 572:
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Together, 1053: Ten Thousand, 152: Hamster Ball, 1196: Subways, 231:
Cat Proximity and to what-if articles All the Money (http://what-
if.xkcd.com/111) and Soul Mates (http://what-if.xkcd.com/9) . The
C-remover is a reference to either the T-remover from Leather Goddess
of Phobos (https://en.wikipedia.org
/wiki/Leather_Goddesses_of_Phobos) or the multi-letter remover from
Counterfeit Monkey (http://emshort.com/counterfeit_monkey/) , a text
adventure by Emily Short inspired by it. At one point in the maze, the
options to travel are N, S, and Dennis instead of the usual N, E, S, W;
this is a reference to the text-based game Thy Dungeonman
(http://www.hrwiki.org/wiki/Thy_Dungeonman) found in a Strong Bad
email from homestarrunner.com (http://homestarrunner.com) .

Hoverboard> Links to 1608: Hoverboard browser game.

Mornington Crescent> This is a simulation of the well-known game
Mornington Crescent, which bears a surprising resemblance to London's
Underground railway network. Players name a station, in turn,
endeavouring to reach Mornington Crescent. The rules of play are very
complicated and beyond the scope of this article; interested persons are
referred to N. F. Stovold’s Mornington Crescent: Rules and Origins
(sadly out of print). In this variation, one may reach 'Vauxhall'>'Easter
basket'>'Take egg', also allowing you to save. The shortest path to the
Easter basket is: Euston / Warren Street / Oxford Circus / Green Park /
Victoria / Pimlico / Vauxhall / Easter basket

All playable stations are immediately adjacent on the London
Underground network to the station last played. Despite the fact that this
version of the game starts at Euston, which is adjacent to Mornington
Crescent, the branch of the Northern line on which the eponymous
station is situated does not appear in the game.

8 Help

Contains various
submenus, all of
which, barring
Credits, loop back
recursively to this
menu:

Tutorial

Support

Manual

Troubleshooting

FAQ

Guide

Q&A

User forums
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Credits> 'Some people who helped with this comic: @chromakode
(http://chromakode.com/) Amber (https://twitter.com/aiiane)
@fadinginterest (https://twitter.com/fadinginterest) Kat
(https://twitter.com/wirehead2501) Kevin (https://twitter.com/cotrone)
Stereo (http://90d.ca/) '

9 Do
Crimes

Contains several
"crimes" that can
be committed. This
option is unlocked
by File > Open >
C:\ (or /home/user)
> Bookmarks/ >
Secret > Enable
Dark Web.

Steal Bitcoins > Grayed out.

Say swears > Several clean swears that all link to 771: Period Speech.

Hack > Three sub-options that link to various related comics. (Gibson:
Nothing. Election: 1019: First Post. Planet: 1337: Hack.)

Forge a Scrabble Tile > Several sub-options that don't do anything. (U,
Z, <this menu option intentionally left blank>, and two special
characters, one being a Russian 'Э', as low-pitched [eh], and the second
being a crossed swords emoji (⚔)

Filesystems Menu
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Drive Menu Item Explanation Sub-Menu Items

A:\ Insert Only appears before inserting a floppy
disk.

Floppy disk> Unlocks other options for
drive A:\, which are identical to drive C:\

Chip card> A long sequence of being told
'Please wait. Authorizing...' ending in 'Chip
error! REMOVE CARD NOW!'

C:\ Documents/ Nothing. None.

C:\ Music/

Leads to a long string of prompts for
song lyrics. 'Hey now / Hey now na
now / Sing "This Corrosion" to me'
inverts the webpage's color before
Easter egg mode is enabled, and plays
the referenced song in the browser
with inverted color and flashing if the
Easter egg mode is enabled. It's
actually the same menu that is shown
under Utilities>Identify song (which
itself is a menu-ised version of 851:
Na).

'Hey now / Hey now / Don't dream it's over'
links to 240: Dream Girl. 'This / is / a / story
all about how / my life got flipped, turned
upside down' links to 464: RBA. 'This / is /
the / story of a girl / who cried a river and
drowned the whole world' links to a Youtube
video: https://www.youtube.com
/watch?v=8_FVAEYRM5I

C:\ Bookmarks/

Similar to Music/, Bookmarks/>
Comics leads to a chain from which
many comics are titled and linked.
Probably all comics actually. For
instance he thus here recognizes his
first April Fools' comic 404: Not
Found, which cannot be found, as a
real comic by linking to it.
Bookmarks/> Secret> Enable Dark
Web adds the 'Dark Web' option to the
initial menu.

C:\ Games/ Same as 'Games' from the initial
menu.

C:\ Sequences/

The options are the lines from a Tim
and Eric sketch Celery Man
(http://knowyourmeme.com/memes
/celery-man) ; the final option links to
a YouTube video of the sketch.

After several single-option menus, it links to
this Youtube video.
https://www.youtube.com
/watch?v=MHWBEK8w_YY

/ home/ Nothing.

uniXKCD]. UniXKCD is itself something of
an April Fools comic, as it was created on
April 1st 2010 while the comic from the day
before, 721: Flatland was still up, i.e. it was
not an April fools' comic. In addition to
having a comic browsing interface, there are
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several one line responses (hint can give
'Use the source, Luke!'), a text-based
adventure, and some commands (like man
cat) do something you wouldn't expect (like
saying 'you are now riding a half-man half-
cat'). It is a reference to the Telenet. More on
UniXKCD commands can be found in the
UniXKCD section of the Flatland comoic.

user> Same files as C:\

root> Displays 'You are not in the sudoers
file. This incident will be reported.'

/ opt/ Does nothing. None.
/ sbin/ Does nothing. None.

/ usr/

Opens an infinite sequence of options,
each similar to the last, but replacing
the previous selection with another
folder; probably a reference to the
fact that the /usr hierarchy
(https://www.tldp.org/LDP/Linux-
Filesystem-Hierarchy/html/usr.html)
does contain a list of subdirectories
pretty much identical to those of the
root directory (https://www.tldp.org
/LDP/Linux-Filesystem-Hierarchy
/html/the-root-directory.html) .

/ dev/ Nothing.
random/> links to a random xkcd comic.

urandom/> links to 221: Random Number

Transcript
[Empty frame with Cueball standing slightly right of center.]

[Caption below the frame:]
Editor's Note: Today's comic is optimized for local viewing. To see the full version, just save a copy
of the image!

Trivia
Here is an example of how the game looks when entered:
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Discussion

I created this page manually. DgbrtBOT fail?

Also, notably, while the comic at xkcd.com works as intended (even from Chrome on Android, to a
certain degree), the mobile site, m.xkcd.com, does not. It shows the standard system/browser-specific
context menu. --Videblu (talk) 00:28, 2 April 2018 (UTC)

The BOT didn't fail, the comic just wasn't released on Mon, Wen, or Fri. And in the past there
was no comic on 1. April when it didn't fit into that rule. And the release was LATE; it was
already the 2. April in Europe.--Dgbrt (talk) 09:45, 2 April 2018 (UTC)
The mobile version at m.xkcd.com works fine in Android. --Dgbrt (talk) 10:56, 2 April 2018
(UTC)

Untrue; going to m.xkcd.com on my Android devices brings up a non-interactive
version of the comic, whereas going to xkcd.com (without setting the browser to present
a Desktop client type) works fine. Viewing https://xkcd.com/1975  on mobile works
fine for me; viewing https://m.xkcd.com/1975  does not work properly. I'm on Kit-Kat
& Marshmallow, using the standard browsers; you? ProphetZarquon (talk) 16:04, 2 April
2018 (UTC)

You are right. I don't remember what I've tested before. It cannot work because the
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embedded JavaScript file (https://m.xkcd.com/1975/alto/comic.js) doesn't exist.
Maybe this will be fixed in the future. --Dgbrt (talk) 17:46, 2 April 2018 (UTC)

How are we going to handle submenus submenus and subitems etc? (Also Captcha outdated! Update
immediately!) 162.158.238.34 01:46, 2 April 2018 (UTC)

Um, I don't see a reCapatcha. Just saying...Fmccarthy (talk) 04:17, 2 April 2018 (UTC)
There is one when saving edits. I'm assuming this is the one they mean. Also, aside from
a table with way too many columns I don't really know. 162.158.79.215 04:21, 2 April
2018 (UTC)

Captchas only appear for guests and young accounts. I haven't seen one since
roughly the day after I signed up, LOL! (I commented a lot my first day, "taking"
ownership of all my previous anonymous comments) NiceGuy1 (talk) 04:44, 3
April 2018 (UTC)

Oh my gosh this is incredible. The Games section, especially, is mind boggling. Entropy! Hameltion
(talk) 00:30, 2 April 2018 (UTC)

Whoever owns this site update ReCaptcha! Sizzilingbird (talk) 00:40, 2 April 2018 (UTC)

WOO!!! Unicode XKCD (https://uni.xkcd.com/) !!! Phoenix Up (talk) 00:44, 2 April 2018 (UTC)

2 hours later I'm done, and the save picture button wouldn't work... ripLinker (talk) 11:38, 2 April
2018 (UTC)

This (uni.xkcd.com) is not new, I remember using this months (perhaps years) ago :P PotatoGod
(talk) 02:44, 2 April 2018 (UTC)

 Is there a second for easter eggs in there? Fork bombs ( :(){ :|: &};: ) work, I'm not sure what 
else. Waterlubber (talk) 02:52, 2 April 2018 (UTC)

Sorry if this is already well known, but there are a couple unlisted commands, e.g. you can delete
things individually using rm -rf. It looks like auto-completion and * don't work. Power Factor (talk)
03:27, 2 April 2018 (UTC)

Reluctant to call it an Easter Egg, but Utilities / Identify Song / Hey Now / Hey now na now / Sing
"This Corrosion" to me inverts the colours on the comic/background Maslink (talk) 02:02, 2 April
2018 (UTC)

He missed a chance for a Rick Roll there (For all we know there may be a Rick Roll in here)
Phoenix Up (talk) 02:36, 2 April 2018 (UTC)

SPOILER:

I managed to save the image by playing ADVENT.exe, has anyone else found other ways?
162.158.75.172 00:54, 2 April 2018 (UTC)

COMIC MAY BE UNDER CONSTRUCTION I think one of the menu options change since the
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comic was first posted. Randall may still be changing things. --Videblu (talk) 01:15, 2 April 2018
(UTC)

I agree. It's not just that menu items unlock. On a fresh refresh of the comic, items are there that
weren't there before, such as file > find > who what etc., some that had been greyed out are no
longer grey.
Actually it's that once you do some things others "unlock". For instance, accessing File > Open
> A:\ > Insert > Floppy disk, and then File > Open > A:\ you get the Games, Music, and the
really cool Bookmarks catalog of comics. Also, as said above, completing the game
ADVENT.exe lets you go to save:

Egg spoiler: Text adventure route

Games
ADVENT.EXE
Castle
Well
Pull up the bucket
Examine bucket
Get key
Back
Back to the castle
Open door
Get clamp
This might come in handy
Get outta here
Enter castle
Examine machine
Hmmm
Put clamp in C-Remover
Take lamp
Leave
Go back
Cave
Go deeper
N
E
N
N
N
W
S
W
Examine nest
Take egg
Click

Now you can save the image (https://i.imgur.com/X4LX3w9.png) ! :)

I made it hidden so that anyone who wants to explore on their own may still... Hameltion (talk)
02:01, 2 April 2018 (UTC)
How did you solve the maze? Is there a clue anywhere or just brute force? 141.101.98.196 (talk)
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(please sign your comments with ~~~~)
When at the Well, maybe try wishing for wisdomSteampunkery (talk) 19:44, 2 April
2018 (UTC)
The Help menu changed after I refreshed the page (that is what I see at first glance),
other things may have changed as well. Phoenix Up (talk) 02:29, 2 April 2018 (UTC)

Ah - I don't recall it being different, but I may have missed an earlier version.
Anyway here is another way to make the image available:

C-remover is a reference to the interactive fiction "Counterfeit Monkey (http://emshort.com
/counterfeit_monkey/) ". (Adding it for future restructure) 162.158.134.142 08:00, 2 April 2018
(UTC)

I claimed earlier that it was a Counterfeit Monkey reference on the Reddit thread, but
someone who worked on the comic pointed out on Twitter (https://twitter.com
/wirehead2501/status/980703946971860993) that it is actually a reference to "Leather
Goddesses of Phobos", though Counterfeit Monkey also uses that mechanic.
172.69.90.52 16:23, 2 April 2018 (UTC)

Egg spoiler: London Underground route

.

Games
Mornington Crescent
Euston
Warren Street
Oxford Circus
Green Park
Victoria
Pimlico
Vauxhall
Easter basket
Take egg (Click)

Though in reality it may be faster to bike (https://www.google.com/maps/dir
/Mornington+Crescent,+London+NW1+2JA,+United+Kingdom/Vauxhall,+London,+UK
/@51.5103249,-0.1720918,13z
/data=!3m1!4b1!4m14!4m13!1m5!1m1!1s0x48761b2037dd36b9:0x11812a2d5cfb2ea3!2m2!1d-
0.1388607!2d51.5343884!1m5!1m1!1s0x487604ec2b79a13d:0xdfa3f51e98dee89c!2m2!1d-
0.1227798!2d51.4861366!3e1) ?

This is really fun! (and there's this (https://xkcd.com/1975/kat-bun-small.png) )
--Hameltion (talk) 02:43, 2 April 2018 (UTC)

I followed the "Land of 1000 dances" "na-na"s over 1000 times and didn't hit an end. It may be
infinite. Jedi.jesse (talk) 02:45, 2 April 2018 (UTC)

Doing System > / > home/ > guest (click) takes you to uni.xkcd.com (https://uni.xkcd.com/) which
it pretty neat. Hameltion (talk) 02:53, 2 April 2018 (UTC)

List of D&D spells can be ported into explanation from here (https://www.reddit.com/r/dndnext
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/comments/88vwoe/xkcds_latest_comic_has_a_dd_easter_egg/) . And here (https://www.reddit.com
/r/xkcd/comments/88v6if/xkcd_1975_right_click/dwnp4ml/) is a path through Mornington Crescent
to an easter egg. 162.158.134.142 07:52, 2 April 2018 (UTC)

https://en.wikipedia.org/wiki/Mornington_Crescent_(game) Mornington Crescent is a joke
nonsensical game from an old British radio show. 141.101.98.142 (talk) (please sign your comments with ~~~~)

You actually can install apt with brew. It can't actually install anything because it needs to create a
package record during the initial operating system install, but you can do it if you want to. Not sure
why you would though. EDIT: I can't find the package anymore, but I am pretty sure I was able to do
this at one point. Might have been removed due to uselessness. 172.68.34.64 00:08, 3 April 2018
(UTC)

Land of 1,000 Dances

This goes on forever. Or at least well over 1000 levels: [Media:https://i.imgur.com/iiHDE3e.png
number of popups checked with jQuery]--MikeOShay (talk) 04:21, 2 April 2018 (UTC)

Transscript

Is the transscript really unfinished? It transcribes the entirety of the comic image itself, and the menu
part is in explanations. 162.158.238.142 05:36, 2 April 2018 (UTC)

Release date

This comic was probably released on April 2, 00:00 UTC. But of course it was still April 1 in the US.
I don't really care, but the release date here is probably wrong.--Dgbrt (talk) 11:31, 2 April 2018
(UTC)

More discussions

No effect for iOS. --162.158.138.88 05:37, 2 April 2018 (UTC)

If you quickly right click on the comic after refreshing the page, it is possible to save the comic.
Unfortunately there is no easter egg for doing so. Baquea (talk) 12:26, 2 April 2018 (UTC)

Added it to the page. ~~~~ 02:49, 3 April 2018 (UTC)

Katamari in the music bit is a reference to this song (https://youtu.be/iMH49ieL4es?t=48s)
--141.101.99.137 13:31, 2 April 2018 (UTC)

spell list (half of it, i didnt test spells with material components): --norill

Spellbook
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V S M L School Spell Class Result

V - - 2 Illusion Blur Wizard Causes the screen/comic to
appear blurry

V - - 2 Illusion Blur Sorcerer Causes the screen/comic to
appear blurry

V - - 5 Divination Contact Other Plane Wizard
V - - 5 Divination Contact Other Plane Warlock
V - - 1 Divination Hunter's Mark Ranger
V - - 2 Necromancy Blindness/Deafness Wizard
V - - 2 Necromancy Blindness/Deafness Sorcerer
V - - 2 Necromancy Blindness/Deafness Cleric
V - - 2 Necromancy Blindness/Deafness Bard
V - - 9 Enchantment Power Word Kill Wizard
V - - 9 Enchantment Power Word Kill Sorcerer
V - - 9 Enchantment Power Word Kill Warlock
V - - 9 Enchantment Power Word Kill Bard

V - - 8 Enchantment Power Word Stun Wizard Links to https://what-
if.xkcd.com/156/

V - - 8 Enchantment Power Word Stun Sorcerer Links to https://what-
if.xkcd.com/156/

V - - 8 Enchantment Power Word Stun Warlock Links to https://what-
if.xkcd.com/156/

V - - 8 Enchantment Power Word Stun Bard Links to https://what-
if.xkcd.com/156/

V - - 6 Enchantment Irresistible Dance Wizard Links to https://xkcd.com/878/
V - - 6 Enchantment Irresistible Dance Bard Links to https://xkcd.com/878/

V - - 5 Enchantment Geas Wizard Links to https://xkcd.com
/1559/

V - - 5 Enchantment Geas Paladin Links to https://xkcd.com
/1559/

V - - 5 Enchantment Geas Druid Links to https://xkcd.com
/1559/

V - - 5 Enchantment Geas Cleric Links to https://xkcd.com
/1559/

V - - 5 Enchantment Geas Bard Links to https://xkcd.com
/1559/

V - - 1 Enchantment Command Paladin Links to https://xkcd.com/857/
V - - 1 Enchantment Command Cleric Links to https://xkcd.com/857/
V - - 0 Enchantment Vicious Mockery Bard Links to https://xkcd.com/732/
V - - 9 Transmutation Time Stop Wizard
V - - 9 Transmutation Time Stop Sorcerer
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V - - 8 Transmutation Glibness Warlock
V - - 8 Transmutation Glibness Bard
V - - 2 Transmutation Knock Wizard
V - - 2 Transmutation Knock Sorcerer
V - - 2 Transmutation Knock Bard
V - - 0 Transmutation Thaumaturgy Cleric
V - - 9 Conjuration Wish Wizard
V - - 9 Conjuration Wish Sorcerer
V - - 6 Conjuration Word of Recall Cleric
V - - 4 Conjuration Dimension Door Wizard
V - - 4 Conjuration Dimension Door Warlock
V - - 4 Conjuration Dimension Door Sorcerer
V - - 4 Conjuration Dimension Door Bard
V - - 4 Conjuration Guardian of Faith Cleric
V - - 2 Conjuration Misty Steep Wizard
V - - 2 Conjuration Misty Steep Warlock
V - - 2 Conjuration Misty Steep Sorcerer
V - - 7 Evocation Divine Word Cleric
V - - 3 Evocation Mass Healing Word Cleric
V - - 2 Evocation Prayer of Healing Cleric
V - - 2 Evocation Branding Smite Paladin
V - - 1 Evocation Healing Word Druid
V - - 1 Evocation Healing Word Cleric
V - - 1 Evocation Healing Word Bard
V - - 1 Evocation Faerie Fire Druid
V - - 1 Evocation Faerie Fire Bard
V S - 9 Illusion Weird Wizard
V S - 7 Illusion Mirage Arcane Wizard
V S - 7 Illusion Mirage Arcane Druid
V S - 7 Illusion Mirage Arcane Bard
V S - 5 Illusion Seeming Wizard
V S - 5 Illusion Seeming Sorcerer
V S - 5 Illusion Seeming Bard
V S - 4 Illusion Greater Invisibility Wizard
V S - 4 Illusion Greater Invisibility Sorcerer
V S - 4 Illusion Greater Invisibility Bard
V S - 4 Illusion Phantasmal Killer Wizard
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V S - 3 Illusion Phantom Steed Wizard
V S - 2 Illusion Mirror Image Wizard
V S - 2 Illusion Mirror Image Warlock
V S - 2 Illusion Mirror Image Sorcerer
V S - 2 Illusion Silence Ranger
V S - 2 Illusion Silence Cleric
V S - 2 Illusion Silence Bard
V S - 1 Illusion Disguise Self Wizard
V S - 1 Illusion Disguise Self Sorcerer
V S - 1 Illusion Disguise Self Bard

V S - 5 Divination Commune with
Nature Ranger

V S - 5 Divination Commune with
Nature Druid

V S - 2 Divination Find Traps Ranger
V S - 2 Divination Find Traps Druid
V S - 2 Divination Find Traps Cleric
V S - 1 Divination Detect Magic Wizard
V S - 1 Divination Detect Magic Sorcerer
V S - 1 Divination Detect Magic Ranger
V S - 1 Divination Detect Magic Paladin
V S - 1 Divination Detect Magic Druid
V S - 1 Divination Detect Magic Cleric
V S - 1 Divination Detect Magic Bard
V S - 1 Divination Speak with Animals Ranger
V S - 1 Divination Speak with Animals Druid
V S - 1 Divination Speak with Animals Bard
V S - 1 Divination Detect Evil and Good Paladin
V S - 1 Divination Detect Evil and Good Cleric
V S - 0 Divination Guidance Druid
V S - 0 Divination Guidance Cleric
V S - 7 Necromancy Finger of Death Wizard
V S - 7 Necromancy Finger of Death Warlock
V S - 7 Necromancy Finger of Death Sorcerer
V S - 6 Necromancy Eyebite Wizard
V S - 6 Necromancy Eyebite Warlock
V S - 6 Necromancy Eyebite Sorcerer
V S - 6 Necromancy Eyebite Bard
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V S - 6 Necromancy Harm Cleric
V S - 5 Necromancy Contagion Druid
V S - 5 Necromancy Contagion Cleric
V S - 4 Necromancy Blight Wizard
V S - 4 Necromancy Blight Warlock
V S - 4 Necromancy Blight Sorcerer
V S - 4 Necromancy Blight Druid
V S - 3 Necromancy Vampiric Touch Wizard
V S - 3 Necromancy Vampiric Touch Warlock
V S - 3 Necromancy Bestow Curse Wizard
V S - 3 Necromancy Bestow Curse Cleric
V S - 3 Necromancy Bestow Curse Bard
V S - 2 Necromancy Ray of Enfeeblement Wizard
V S - 2 Necromancy Ray of Enfeeblement Warlock
V S - 1 Necromancy Inflict Wounds Cleric
V S - 0 Necromancy Chill Touch Wizard
V S - 0 Necromancy Chill Touch Warlock
V S - 0 Necromancy Chill Touch Sorcerer
V S - 8 Enchantment Dominate Monster Wizard
V S - 8 Enchantment Dominate Monster Warlock
V S - 8 Enchantment Dominate Monster Sorcerer
V S - 8 Enchantment Dominate Monster Bard
V S - 5 Enchantment Dominate Person Wizard
V S - 5 Enchantment Dominate Person Sorcerer
V S - 5 Enchantment Dominate Person Bard
V S - 5 Enchantment Modify Memory Wizard
V S - 5 Enchantment Modify Memory Bard
V S - 4 Enchantment Dominate Beast Sorcerer
V S - 4 Enchantment Dominate Beast Druid
V S - 4 Enchantment Compulsion Bard
V S - 2 Enchantment Enthrall Warlock
V S - 2 Enchantment Enthrall Bard
V S - 2 Enchantment Zone of Truth Paladin
V S - 2 Enchantment Zone of Truth Cleric
V S - 2 Enchantment Zone of Truth Bard
V S - 2 Enchantment Calm Emotions Cleric
V S - 2 Enchantment Calm Emotions Bard
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V S - 1 Enchantment Charm Person Wizard
V S - 1 Enchantment Charm Person Warlock
V S - 1 Enchantment Charm Person Sorcerer
V S - 1 Enchantment Charm Person Druid
V S - 1 Enchantment Charm Person Bard
V S - 1 Enchantment Heroism Paladin
V S - 1 Enchantment Heroism Bard
V S - 8 Transmutation Animal Shapes Druid
V S - 7 Transmutation Etherealness Wizard
V S - 7 Transmutation Etherealness Warlock
V S - 7 Transmutation Etherealness Sorcerer
V S - 7 Transmutation Etherealness Cleric
V S - 7 Transmutation Etherealness Bard
V S - 5 Transmutation Telekinesis Wizard
V S - 5 Transmutation Telekinesis Sorcerer
V S - 5 Transmutation Animate Objects Wizard
V S - 5 Transmutation Animate Objects Sorcerer
V S - 5 Transmutation Animate Objects Bard
V S - 4 Transmutation Fabricate Wizard
V S - 4 Transmutation Giant Insect Druid
V S - 3 Transmutation Blink Wizard
V S - 3 Transmutation Blink Sorcerer
V S - 3 Transmutation Plant Growth Ranger
V S - 3 Transmutation Plant Growth Druid
V S - 3 Transmutation Plant Growth Bard
V S - 3 Transmutation Speak with Plants Ranger
V S - 3 Transmutation Speak with Plants Druid
V S - 3 Transmutation Speak with Plants Bard
V S - 3 Transmutation Meld into Stone Druid
V S - 3 Transmutation Meld into Stone Cleric
V S - 2 Transmutation Alter Self Wizard
V S - 2 Transmutation Alter Self Sorcerer
V S - 2 Transmutation Magic Weapon Paladin
V S - 1 Transmutation Expeditious Retreat Wizard
V S - 1 Transmutation Expeditious Retreat Warlock
V S - 1 Transmutation Expeditious Retreat Sorcerer

V S - 1 Transmutation Purify Food and
Drink Paladin
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V S - 1 Transmutation Purify Food and
Drink Druid

V S - 1 Transmutation Purify Food and
Drink Cleric

V S - 0 Transmutation Prestidigitation Wizard
V S - 0 Transmutation Prestidigitation Warlock
V S - 0 Transmutation Prestidigitation Sorcerer
V S - 0 Transmutation Prestidigitation Bard
V S - 0 Transmutation Druidcraft Druid
V S - 9 Abjuration Prismatic Wall Wizard
V S - 8 Abjuration Mind Blank Wizard
V S - 8 Abjuration Mind Blank Bard
V S - 4 Abjuration Death Ward Paladin
V S - 4 Abjuration Death Ward Cleric

V S - 3 Abjuration Protection from
Energy Wizard

V S - 3 Abjuration Protection from
Energy Sorcerer

V S - 3 Abjuration Protection from
Energy Ranger

V S - 3 Abjuration Protection from
Energy Druid

V S - 3 Abjuration Remove Curse Wizard
V S - 3 Abjuration Remove Curse Warlock
V S - 3 Abjuration Remove Curse Paladin
V S - 3 Abjuration Remove Curse Cleric
V S - 3 Abjuration Dispel Magic Wizard
V S - 3 Abjuration Dispel Magic Warlock
V S - 3 Abjuration Dispel Magic Sorcerer
V S - 3 Abjuration Dispel Magic Paladin
V S - 3 Abjuration Dispel Magic Druid
V S - 3 Abjuration Dispel Magic Cleric
V S - 3 Abjuration Dispel Magic Bard
V S - 3 Abjuration Beacon of Hope Cleric
V S - 2 Abjuration Lesser Restoration Ranger
V S - 2 Abjuration Lesser Restoration Paladin
V S - 2 Abjuration Lesser Restoration Druid
V S - 2 Abjuration Lesser Restoration Cleric
V S - 2 Abjuration Lesser Restoration Bard
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V S - 2 Abjuration Protection from
Poison Ranger

V S - 2 Abjuration Protection from
Poison Paladin

V S - 2 Abjuration Protection from
Poison Druid

V S - 2 Abjuration Protection from
Poison Cleric

V S - 1 Abjuration Shield Wizard
V S - 1 Abjuration Shield Sorcerer
V S - 9 Conjuration Storm of Vegance Druid
V S - 8 Conjuration Maze Wizard
V S - 8 Conjuration Incendiary Cloud Wizard
V S - 8 Conjuration Incendiary Cloud Sorcerer
V S - 7 Conjuration Conjure Celestial Cleric
V S - 6 Conjuration Transport via Plants Druid
V S - 6 Conjuration Planar Ally Cleric
V S - 5 Conjuration Cloudkill Wizard
V S - 5 Conjuration Cloudkill Sorcerer
V S - 5 Conjuration Tree Stride Ranger
V S - 5 Conjuration Tree Stride Druid
V S - 3 Conjuration Conjure Animals Ranger
V S - 3 Conjuration Conjure Animals Druid

V S - 3 Conjuration Create Food and
Water Paladin

V S - 3 Conjuration Create Food and
Water Cleric

V S - 3 Conjuration Call Lightning Druid
V S - 2 Conjuration Find Steed Paladin
V S - 1 Conjuration Fog Cloud Wizard
V S - 1 Conjuration Fog Cloud Sorcerer
V S - 1 Conjuration Fog Cloud Ranger
V S - 1 Conjuration Fog Cloud Druid
V S - 1 Conjuration Entangle Druid
V S - 0 Conjuration Acid Splash Wizard
V S - 0 Conjuration Acid Splash Sorcerer
V S - 0 Conjuration Poison Spray Wizard
V S - 0 Conjuration Poison Spray Warlock
V S - 0 Conjuration Poison Spray Sorcerer
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V S - 0 Conjuration Poison Spray Druid
V S - 0 Conjuration Mage Hand Wizard
V S - 0 Conjuration Mage Hand Warlock
V S - 0 Conjuration Mage Hand Sorcerer
V S - 0 Conjuration Mage Hand Bard
V S - 0 Conjuration Produce Flame Druid
V S - 9 Evocation Meteor Swarm Wizard
V S - 9 Evocation Meteor Swarm Sorcerer
V S - 9 Evocation Mass Heal Cleric
V S - 7 Evocation Prismatic Spray Wizard
V S - 7 Evocation Prismatic Spray Sorcerer
V S - 7 Evocation Fire Storm Sorcerer
V S - 7 Evocation Fire Storm Druid
V S - 7 Evocation Fire Storm Cleric
V S - 6 Evocation Heal Druid
V S - 6 Evocation Heal Cleric
V S - 6 Evocation Blade Barrier Cleric
V S - 5 Evocation Mass Cure Wounds Druid
V S - 5 Evocation Mass Cure Wounds Cleric
V S - 5 Evocation Mass Cure Wounds Bard
V S - 3 Evocation Daylight Ranger
V S - 3 Evocation Daylight Paladin
V S - 3 Evocation Daylight Druid
V S - 3 Evocation Daylight Cleric
V S - 2 Evocation Scorching Ray Wizard
V S - 2 Evocation Scorching Ray Sorcerer
V S - 2 Evocation Spiritual Weapon Cleric
V S - 1 Evocation Burning Hands Wizard
V S - 1 Evocation Burning Hands Sorcerer
V S - 1 Evocation Magic Missle Wizard
V S - 1 Evocation Magic Missle Sorcerer
V S - 1 Evocation Thunderwave Wizard
V S - 1 Evocation Thunderwave Sorcerer
V S - 1 Evocation Thunderwave Druid
V S - 1 Evocation Thunderwave Bard
V S - 1 Evocation Hellish Rebuke Warlock
V S - 1 Evocation Cure Wounds Ranger
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V S - 1 Evocation Cure Wounds Paladin
V S - 1 Evocation Cure Wounds Druid
V S - 1 Evocation Cure Wounds Cleric
V S - 1 Evocation Cure Wounds Bard
V S - 1 Evocation Divine Favor Paladin
V S - 1 Evocation Guiding Bolt Cleric
V S - 0 Evocation Fire Bolt Wizard
V S - 0 Evocation Fire Bolt Sorcerer
V S - 0 Evocation Ray of Frost Wizard
V S - 0 Evocation Ray of Frost Sorcerer
V S - 0 Evocation Shocking Gasp Wizard
V S - 0 Evocation Shocking Gasp Sorcerer
V S - 0 Evocation Eldritch Blast Warlock
V S - 0 Evocation Sacred Flame Cleric

172.68.110.52 (talk) (please sign your comments with ~~~~)

Recursive package managers are perfectly sane if the two package managers use different
repositories, for example apt install python3-pip. The true hilarity arrives if you install a package
manager for the sole purpose of installing another, or if they use the same repositories. But that's not
unheard of either: apt install npm && npm install yarn -78.68.24.134 but your site thinks I'm
162.158.134.130 16:42, 2 April 2018 (UTC)

Bing image search

Surprisingly, when you are playing 20 questions and get into the section with the animals, all of the
image requests go to Bing.

I'm curious if anyone will look at the traffic of Bing and compare the normal traffic with the traffic
from this comic. I want to see just how much of a spike Bing image search gets from this.

And by the way, "Bing" is actually a red underlined misspelling according to Firefox. Keybounce
(talk) 19:48, 2 April 2018 (UTC)

Is there a reason why UniXKCD is under comic 721? Also, there are significant things missing from
it, especially the special ctrl- functions! ChunyangD (talk) 02:56, 3 April 2018 (UTC)

I read the comic, tried to save, it saved. Check what saved, was the same comic. How boring. LOL!
Guess Randall doesn't think people read XKCD on iPads (or maybe just that he doesn't think anybody
is reading on an iPad 1 with iOS 5.1.1). :) NiceGuy1 (talk) 04:44, 3 April 2018 (UTC)

Not your iOS 5.1.1's problem, basically all the interactive comics are like that with iPads, even
if using iOS 10. (On my iPad, 1608: Hoverboard works but lags and controls are awful, 1663:
Garden can't run, 1037: Umwelt refuses to appear, you can't do anything in 1193: Externalities,
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and as for this comic... *flips table* ) The only comic that works perfectly on my iPad is 1350:
Lorenz. Herobrine (talk) 11:25, 3 April 2018 (UTC)

Yeah, that's been my experience. I remember for Umwelt I got what looked like a black
hole, which I think might have been the titular Umwelt. I seem to recall the description
identified that as being some obscure set up I've never heard of, LOL! I also remember
Garden didnt even do anything on my computer! I could change the lights, but that was
it. I can't remember Externalities and Lorenz by name. But since my iPad CAN save
images I hoped this would be different. Like saving it would, as promised, save a
different comic (like Umwelt showed a different comic depending on your set up and
connection). *sigh* NiceGuy1 (talk) 04:28, 6 April 2018 (UTC)
EDIT: Checking now, can't remember seeing Externalities, I've certainly never tried it on
a computer (I think I just dismissed it as "Oh well" and moved on). Lorenz I did indeed
try it a bit on a computer. Hoverboard I went literally everywhere reachable, LOL!
NiceGuy1 (talk) 04:34, 6 April 2018 (UTC)

Graph

This (https://i.imgur.com/4X4jD6j.png) is what the whole network of menus looks like, minus the
massive Comics tree. The big cluster near the center is the DnD game, and the single-file trail on the
left is Who's on First. Blue circles are menus, red are links, purple are client-side JS calls, pinks are
null (they just collapse the menu), and yellows are "tags" - client-side state variables that are set or
unset by some menu options. The orphaned pair of grey dots at the top are the Save menu, which is
only visible when a tag is set by the ADVENT.EXE or Mornington Crescent games. I'll try to make
this some kind of interactive graph that people can explore - the actual DB I made contains more data
than is visible in the image. Okofish (talk) 15:27, 3 April 2018 (UTC)

I made a scraper that downloads all the jsons, and also makes a graphviz graph. Code:
https://github.com/ad1217/xkcd1975scraper, Graph: https://raw.githubusercontent.com/ad1217
/xkcd1975scraper/master/out.svg (save the graph and open it in Inkscape or something, it is rather
large). Ad1217 (talk) 19:58, 3 April 2018 (UTC)

Where is the javascript source?

Where is the source file for this comic? I had trouble figuring out what was happening from opening
my browser console. I can usually figure out things like e.g. kittens game, etc. Which file has the
source for the right click menu in this comic? 108.162.210.130 17:41, 3 April 2018 (UTC)

It's here (https://xkcd.com/1975/alto/comic.js) , but the interesting stuff happens server-side.
You'll get more info by looking at the network tab in your browser's developer tools. Okofish
(talk) 19:03, 3 April 2018 (UTC)

None of the "links to ___" things actually link to anything here. I guess they use window.open or
something similarly silly that does not work in real browsers. 162.158.210.88 08:43, 4 April 2018
(UTC)

When you play the "Backup" noise, the audio quality isn't that great, it seems to be recorded from a
device. Also, you can hear what seems to be a bird chirping and a mouse click. Can anyone else
verify this? 625571b7-aa66-4f98-ac5c-92464cfb4ed8 (talk) 22:39, 4 April 2018 (UTC)
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This morning I tried to follow the path in the cave again (in ADVENT.EXE) but found that it's
changed, the cave leads me to a "grue" which ate me, now ADVENT.EXE just returns "you've been
eaten by a grue" and doesn't let me go anywhere. 108.162.221.113 13:06, 5 April 2018 (UTC) Sam

Sooooo just FYI, any similarities to Ready Player One are 100% unintentional. (I can't speak for
Randall but I worked on that bit and I haven't read/seen it.) It was just an Easter egg unlock because it
was... literally Easter. And we put it there and in Mornington Crescent as the longest/most
complicated paths. Apparently if you throw enough 80s/90s nerd references at the wall now, you get
Ready Player One. ¯\_(ツ)_/¯ 172.68.141.232 18:46, 5 April 2018 (UTC)

Retrieved from "https://www.explainxkcd.com/wiki/index.php?title=1975:_Right_Click&oldid=155498"
Categories: All comics Comics from 2018 Comics from April Sunday comics
Incomplete explanations Links to xkcd.com Interactive comics April fools' comics
Comics featuring Cueball

This page was last modified on 7 April 2018, at 01:39.
This page has been accessed 47,461 times.

1975: Right Click - explain xkcd http://www.explainxkcd.com/wiki/index.php?title=1975:_Right_Cl...

26 of 26 2018-04-06, 11:39 PM


